This version of the software has been retired.
This version of the software has been retired.
This version of the software has been retired.
Migrating your company data from version 19.8 ................................................................. 31

**Known Issues and Comments** ................................................................. 35

General ........................................................................................................ 35
Windows 8.1 Professional and Server 2012 Standard Operating Systems ................. 42
Windows 7 Professional and Server 2008 R2 Standard Operating Systems ................. 43

This version of the software has been retired
This version of the software has been retired.
April 2018 Update 3 (Build 20.7.34)

This section describes tax changes included in this update, as well as program fixes and enhancements implemented since March 2018 Update 2.

U.S. Payroll Tax Tables—April 2018 Update 3

Payroll tax tables have changed for the following jurisdictions:

- Michigan
- Missouri

Fixes for the U.S. Edition

The following issue was fixed specifically for the U.S. Edition of Sage 100 Contractor:

- On Aatrix Certified Payroll reports for Missouri and California, overtime and double time are reported separately.

Fix for the Canadian Edition

The following issue was fixed specifically for the Canadian edition:

- Vacation time is now accrued properly in the 5-2-1 Employees window.
March 2018 Update 2 (Build 20.7.31)

This section describes tax changes included in this update, as well as program fixes and enhancements implemented since the January 2018 update.

U.S. Payroll Tax Tables

Payroll tax tables have changed for the following jurisdictions in this update:

- Louisiana
- North Dakota

Enhancements in this Update

- In both the U.S. and Canadian Editions, you can now choose to include attachments from the original order when you repeat a work order multiple times.

Fixes for the U.S. Edition

- This update fixes an issue that prevented the 5-1-4-61 State Tax report from printing properly.
January 2018 Update 1 (Build 20.7.28)

This section describes tax changes included in this January update. It also includes program fixes implemented since the year-end update released in December 2017.

U.S. Payroll Tax Tables

Federal Payroll Tax Changes

Federal payroll tax tables have been updated for 2018.

**Note:** Sage 100 Contractor now calculates the tax on separately identified supplemental wages less than or equal to $1 million at 22%, rather than the previous rate of 25%. (You still need to calculate it manually if supplemental wages exceed $1 million.)

For details of tax changes, visit the IRS website at [https://www.irs.gov](https://www.irs.gov).

State and Other Government-Mandated Payroll Tax Changes

Payroll tax tables have changed for the following jurisdictions in this update:

- Kentucky
- Mississippi
- Missouri
- Oregon

Fixes—Version 20.7 January 2018 Update

We have fixed the following issues in the January 2018 product update for Sage 100 Contractor Version 20.7:

- We have fixed the data type for the Link# field in the U-3 Unitary Billing window. The field is now formatted as a 10-digit numeric field, with no decimals, consistent with other windows that use the same field.
- The U-5-1 Daily Payroll Entry window again uses the department from the equipment code as a default when there is no specified department for the job or the cost code.
- You can redirect reports to a printer that is not the default printer, as you could in earlier versions.
- In Database Administration, when you press F1 for any of the Server Management tabs, the program displays the correct help page.
December 2017 Year-End Update

This section describes tax changes, program fixes, and enhancements included in version 20.7, the year-end release of Sage 100 Contractor 2017.

U.S. Payroll Tax Tables—December 2017

Federal Payroll Tax Changes

Federal income tax rates for 2018 have not yet been finalized. When the federal tax rates are available, we will provide a new product update, which will include any additional state tax changes.

State and Other Government-Mandated Payroll Tax Changes

Payroll tax tables changed for the following jurisdictions for 2018:

- California
- District of Columbia
- Illinois
- Maine
- Maryland
- Minnesota
- New York
- New York City and Yonkers
- Rhode Island
- South Carolina
Canadian Payroll Tax Tables—December 2017

This section highlights federal, provincial, and Quebec tax changes.

For more information about these changes, and for information on Employment Insurance, see the Canada Revenue Agency website.

Federal Payroll Tax Changes

Changes to Canadian payroll taxes for 2018 include the following:

- Income tax thresholds and many personal amounts changed.
- EI maximum annual insurable earnings and the EI premium rate changed.
- CPP maximum pensionable earnings changed.
- The Canada Employment credit amount changed for 2018.

Quebec Payroll Tax Changes

Changes to Quebec payroll taxes for 2018 include the following:

- The indexation rate used to calculate the value of personal tax credits changed.

**Important!** To apply the indexation factor for the new year, you must update the Quebec Personal Tax Credits for Quebec employees on the Options menu in the 5-2-1 Employees window.

- The QPP maximum contribution amount changed.
- The QPIP maximum insurable earnings changed.

Other Provincial and Territorial Payroll Tax Changes

The following provinces and territories mandated payroll tax changes, effective January 1, 2018:

- Alberta
- British Columbia
- Manitoba
- New Brunswick
- Newfoundland and Labrador
- Northwest Territories
- Nova Scotia
- Nunavut
- Ontario
- Prince Edward Island
- Quebec
- Saskatchewan
- Yukon

For detailed information on personal amounts, see the TD1 form for each province or territory.
Enhancements in version 20.7

This section describes the new features and enhancements you will find in version 20.7.

**Enhancements for the U.S. Edition**

- You can now print a new *5-1-8-86 Vacation Hours Earned and Used Report*. 

---

7 Sage 100 Contractor
Fixes in version 20.7

Fixes in the U.S. and Canadian Editions

Version 20.7 includes the following software fixes in both editions:

- In the 1-7 General Ledger Accounts window, when you use the account lookup window to set one account or several accounts inactive, your changes are saved correctly.

- In the 3-3-2 Electronic Receipts window, if you leave the Client field blank in the receipt header when you post a cash receipt that includes multiple invoices for multiple clients, you now receive an error message, and Sage 100 Contractor does not post the receipt. (Previously, the receipt was posted, but client subaccounts were not updated properly.)

- When you import a unitary proposal into the 3-9 Unitary Billing window, the imported proposal now includes the descriptions for bid items.

- In the 4-3-1 Select Invoices to Pay window, Sage 100 Contractor correctly recalls any Sort by defaults you saved in the Invoice Selection window.

- You no longer receive an error when you drill down from the 5-1-4-61 State Tax Report.

- You no longer receive a SQL error in the 5-2-3 Compute Payroll window if an employee’s resulting accrued sick or vacation totals go below -99 hours.

- As a non-administrative user, you can now insert and delete rows in the 5-3-4 Paygroups and the 6-5 Cost Codes windows.

- In the 5-5-1 Daily Payroll Entry window, you no longer receive an error when you try to save an entry with a value in the Absence column that is greater than 255.

- The 5-4-3-21 ACA Hours report now indicates overages using the double-dagger (‡) character when viewed on a Windows 10 machine.

- When you drill down from a 6-1-12 Committed Cost Report that includes negative POs, the drilldown report now handles negative quantities correctly.

- In the 6-7-1 Subcontracts grid, when you copy and paste an entire previously saved row, Sage 100 Contractor saves it as a unique new row. (It no longer saves with the same “linref” ID.)

- In the 9-4 Part/Assembly Classes window, we improved the management of relationships between classes.

- The 9-5 Takeoffs window no longer stops working when you load a takeoff that contains formulas that include quotation marks.

- We resolved an issue that caused skipping past columns in several grids.

- You can now print saved queries in portrait, as well as landscape format.

- If you run Sage 100 Contractor on a Terminal Server, or another remote server, and you use printer redirection to enable use of local printers, you no longer lose your default printer for reports each time you log on to the server.

- When you are archiving, if there are errors in the inventory audit, but none in the general ledger audit, choosing to complete the archiving process by clicking [Next] no longer triggers the error “Cannot open database <archivename> requested by the login.”

This Version of the Software has been retired
Upgrading from version 19.8?

New Microsoft SQL Server Platform

Although Sage 100 Contractor 2017 has the same look, feel, and functionality that you are familiar with, its new SQL database structure affords much tighter security and an up-to-date technology on which to build future releases. It also provides several other notable enhancements, including:

- **A new, separate Database Administration tool.** You don't have to be an expert user of Microsoft SQL Server to take advantage of its robust features! We designed Database Administration to optimize your data for Sage 100 Contractor, for example, by keeping related data in expected locations and creating backups automatically before performing certain critical processes. Many of its features are not available through SQL Server Management Studio.

  Significantly, Database Administration includes a migration utility that we have designed and tested extensively to help ensure a smooth and painless transition to SQL Server.

  We have relocated many administrative utilities and functions from the main Sage 100 Contractor program to this new tool. However, we have boosted their capabilities considerably, and now provide easily scheduled maintenance and backup functions to help you to keep your Sage 100 Contractor companies in good order.

  In addition, Database Administration offers several powerful, new capabilities that enable you to maintain tight security and exert fine control over user and program access to your SQL Server instance.

  For a comprehensive list of the utilities you will find in Database Administration, see "Database Administration for Sage 100 Contractor", later in this document.

  **Note:** Database Administration comes with its own help system and a new Database and Company Administration Guide to acquaint you with its features and to guide you in its use.

- **New views for creating reports with third-party report writers.** Because the new views point to the database tables, rather than pointing your reports directly to the tables, we encourage you to use them when creating custom reports using third-party tools, such as Crystal Reports.

  For example, in earlier versions, you would point directly to actpay.vndnme to include Accounts Payable vendor names in custom reports. In the version 20.7 company database, this information resides in dbo.actpay.vndnme. However, we recommend that rather than pointing directly to the table name, you point to the field in the new view: Reports_v1.actpay.vndnme. Report views are located in the Views folder in your company database.
Tip: A compelling reason to use these views is that they may not be affected by many types of changes to the underlying tables, so future database changes will not necessarily "break" your custom reports.

Software and hardware required to support Microsoft SQL Server

Version 20.7 requires an instance of Microsoft SQL Server. You can download and use Microsoft SQL Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and configure Microsoft SQL Express for you.

Refer to Knowledgebase article 84502 (available at available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=84502) for detailed information about supported operating systems and software, and for minimum hardware requirements.

Database Administration for Sage 100 Contractor

The new Database Administration tool is intended for designated system administrators and company administrators. You use it to set up and maintain your company databases, and to select advanced settings to manage communications with and access to your Microsoft SQL Server instance from other programs.

If you have used earlier versions of Sage 100 Contractor, several of these tasks will be familiar to you. For example, Database Administration includes utilities for creating and deleting a company, backing up and restoring company files, and archiving company data that you used in previous Sage 100 Contractor versions.
Important! We highly recommend that you use Database Administration, rather than SQL Management Studio®, to perform the database administration tasks listed below, even if you are an experienced SQL Server user. Besides handling all the database tasks that you are likely to perform in a typical Sage 100 Contractor system, Database Administration was designed to optimize your data for Sage 100 Contractor, for example, by keeping related data in expected locations and creating backups automatically before performing certain critical processes. In the rare event that you need to use SQL Management Studio® to perform a task that is not provided in Database Administration, you should contact Customer Support for assistance.

Database Administration includes the following database and company management utilities:

- **Create Company Based on Existing** and **Create Company** create new Microsoft SQL Server databases.
- **Rename Company** and **Delete Company** are convenient utilities when working with existing companies.
- **Deploy Sample Company** helps you install and refresh the sample data that comes with Sage 100 Contractor.
- **Tune Up Company Databases** performs various maintenance tasks to keep your database functioning efficiently.
- **Back Up Company Databases** enables you to back up your data, “on demand,” whenever needed.
- **Restore Company from Backup** restores a selected backed-up copy of your database.
- **Upgrade Company Databases** prepares your SQL company data so that it is compatible with the most recent version of Sage 100 Contractor.
- **Migrate Company Data** and **Migrate Custom Reports** transfer your version 19.8 company data and custom reports to a new location for Microsoft SQL Server. Migrated files are located in shared folders under \ServerName\CompanyName, organized using a folder structure similar to earlier versions.
- **Schedule Nightly Maintenance** utilities enable you to schedule backup and maintenance operations for times when other users are not logged into the system. You can also select the number of consecutive backups to keep.
- **Manage Company Admin/SQL Logins** utilities enable you to set up or delete logins to the SQL Server database, and to designate a user as a company administrator for a specified Sage 100 Contractor company.
- **Server Management** tools enable you to control the SQL Server instances you use with Sage 100 Contractor easily and efficiently. You can create a new instance on your computer, move companies to the new instance, and remove an instance you no longer need.
- **Advanced Company Settings** lets you specify how long to keep history about database changes for each company, including details about changed records, such as the date and user ID of the employee who made the change. Details older than the retention period you specify are cleared during nightly maintenance. (This history is maintained in separate audit tables, which you can query using SQL Server Management Studio.)
- **The Toolbox** provides a variety of troubleshooting tools to help you track changes in your database, and to diagnose and fix certain types of problems.

11 Sage 100 Contractor

This version of the software has been retired.
Additional Changes for SQL Server

In addition to the new SQL database platform and the Database Administration tool, you should note the following important differences from earlier versions:

- Because each user must now identify themselves to SQL Server using a unique SQL login, there is no longer a single Supervisor user. Instead, you designate as Company Administrators users who require elevated privileges in Sage 100 Contractor.

  Tip: You can copy supervisor preferences used in version 19.8 to individual users in the version 20.7 User List window.

- When starting Sage 100 Contractor, you first log in to an instance of SQL Server using a new Connect to SQL Server window, and then you select your company and type of access from the Company List window.

  If you need to change the type of access after logging into the company, you can return to the Company List window using the Change Company/Access link on the Sage 100 Contractor desktop.

  Note: If you want to log in as a different user, you must close Sage 100 Contractor completely first, and then log in using a different user name.

- You no longer need to reindex your data after upgrading. Now, you use the Database Administration tool migrate your data from version 19.8 and to update it in future.

- Version 20.7 and subsequent releases are installed to a different location than version 19.8 and earlier versions.

  Having separate installation locations enables you to run version 20.7 and version 19.8 on the same computer while you migrate your data to the new version.

  You need to install the License Administration application and activate the software on the same computer as your 19.8 license server, choosing the option to use the computer as the license server for version 20.7. After installing Sage 100 Contractor on other networked workstations, point to this machine as the license server.

  For more information, see the Installation and License Administration Guide.

Notice about Supported Windows Operating Systems

Sage 100 Contractor 2017 supports Windows Server 2008 R2, and later versions of Windows. However, it does not support Windows Server 2008 and Small Business Server 2008 because they do not support .NET 4.6.1, which this version of Sage 100 Contractor requires.

Advanced SQL Server Settings include convenient, sophisticated access and memory management controls for your SQL database.

For detailed information about these utilities and how to use them, see the Database Administration help or refer to the new Database and Company Administration Guide.
For current information about supported operating systems, Internet browsers, and other software, and about system requirements for servers and client workstations, refer to our Knowledgebase article ID 84502, available at https://support.na.sage.com/selfservice/viewdocument.do?externalId=84502.

Installing Sage 100 Contractor 2017

Installing Sage 100 Contractor 2017 and upgrading your data involves a few more steps than in previous editions because you must install two additional components. You need to:

- Install the Database Administration tool on the machine you will use as your server.
- Create a SQL Server instance for Sage 100 Contractor. This process is simplified if you use the option to download Microsoft SQL Server and create an instance automatically when you first open

For detailed instructions on installing Sage 100 Contractor 2017, see "Chapter 3: Sage 100 Contractor Installation," in:

- The Sage 100 Contractor Installation and License Administration Guide (U.S. Edition)
- The Sage 100 Contractor Installation and License Administration Guide (Canadian Edition)

Printable checklists help you get started

Two printable checklists are available to help you get started using Sage 100 Contractor 2017. Download them from our website, print them, and then check off each step on the printed list as you complete the necessary tasks.

- Use the Quick Start Checklist to help you stay on track when you set up your company or migrate your company from version 19.8. It provides an overview of all the important steps you should complete to install version 20.7
- Use the “Going Live” Checklist when you’re ready to start using Sage 100 Contractor 2017 in a production environment (rather than a test environment). It lists all the important steps you should complete to “go live” with Sage 100 Contractor 2017.

Earlier Enhancements in Sage 100 Contractor (SQL)

Earlier versions of Sage 100 Contractor provided a wide variety of new features, including a number of enhancements that our customers have asked for.

This section describes several of the important new features introduced in previous versions. It also provides a comprehensive list of additional features, the details of which you can read about in the Release Notes for the respective version. For more information, see “Summary of Enhancements in Earlier Versions of Sage 100 Contractor (SQL),” on page 28

You Can Set Records "Inactive"

If you are a company administrator, you can now designate records Inactive. For example, you can mark Inactive records that you no longer want to use, but cannot delete because they are referenced by other, current records.

13 Sage 100 Contractor
**Note:** To change Inactive settings, your login ID must be assigned the Company Admin role in the 7-2-2 User List. You do not need to select the Open company with Administrator rights option when you sign into the company.

Sage 100 Contractor prevents entry to inactive records, so you cannot inadvertently process entries using them. For example, you cannot use an inactive cost code on a new purchase order or change the code on an existing record to an inactive cost code.

The 9-5 Takeoff and the 10-3 Schedules lookup windows do not display inactive records. Also, inactive records do not appear in data control boxes, and they are not visible when you search for records using the F9, Page Up, or Page Down keys.

**Note:** Inactive records do not appear in lookup windows by default, but you can display them if you choose to do so. (For information about displaying inactive records, see "Viewing Inactive Records" below.

**Designating Inactive Records**

You designate Inactive records in the following windows by selecting new Edit – Inactive Record for a selected record:

- 1-7 General Ledger Accounts
- General Ledger Subaccounts
- 3-5 Jobs
- 3-6 Receivable Clients
- 4-4 Vendors
- 5-2-1 Employees
- 8-3 Equipment
- 9-2 Parts
- 9-3 Assemblies

In the following windows, which display records in a grid, you enter Y (for Yes) in the Inactive column to set the record for the selected row as Inactive:

- 5-3-2 Workers’ Compensation
- 5-3-4 Paygroups
- 6-5 Cost Codes

If it is necessary to change the Inactive setting later, you simply clear the Inactive Record selection on the Edit menu or the grid.

**Viewing Inactive Records**

From time to time, you may need to check which records of a given type are marked Inactive. For example, when adding a new cost code, to check which codes are already in use, you need to view inactive codes. You can display a list of inactive records in a couple of ways:
For records that display a single record at a time (not in a grid format), you can view all Inactive records of a selected type by opening the associated lookup window, and then clicking **Options > Show Inactive Records**.

A check mark in the **Inactive** column indicates that a record is Inactive.

In windows that display records in grid format, you view Inactive records by selecting the **Show Inactive Records** check box below the grid. The following windows use a grid to display records:

- 5-3-2 Workers' Compensation
- 5-3-4 Paygroups
- 6-5 Cost Codes

**Note:** A Yes entry in the **Inactive** column indicates that a record is inactive. If you are a company administrator, you can change this entry to change the status to and from Inactive.

**Changing the Inactive Settings for Multiple Records at the Same Time**

For windows that do not display records in a grid, you can use the lookup windows to set or clear the Inactive setting for multiple records at once. For example, in the 75 Jobs window:

1. Open the job number lookup window. (Click the down arrow beside the job number data control.)
2. In the lookup window:
   a. Click **Options > Edit Inactive Setting**.
   b. Select or clear the check marks in the Inactive column to change the Inactive setting for the records on the selected rows.

**More efficient log-in**

When you first log in to Sage 100 Contractor, the program creates and stores a personalized list of the companies to which you have access rights, including archived companies.

The next time you log in, Sage 100 Contractor displays in the Company List window only companies from your personal list—provided those companies still exist on the database server—making the log-in process faster.

The program automatically updates personal company lists when companies are added, deleted, renamed or archived in Database Administration. However, if you notice that your list includes a company that you know has been deleted or renamed, or does not include a new company, click the **Refresh Company List** link in the Company List window to recreate your personal company list, removing obsolete companies and inserting the new ones.
Use new custom fields in most windows

With version 20.5, you can define an unlimited number of custom fields for most Sage 100 Contractor windows.

Custom fields enable you to store additional information that you want to keep with Sage 100 Contractor records. As a company administrator, you can add, edit, or delete custom fields for any window that supports them. You can create custom fields for most types of records, except ledger transactions, accounts, daily payroll, and recurring transactions, and you can create an unlimited number of custom fields for a window and for your Sage 100 Contractor company.

Custom fields are not the same as the user-defined fields (UserDef1 and UserDef2) that come with the software. Custom fields are more versatile than the limited user-defined fields.

**Note:** Windows that support custom fields include a new **Custom Fields** option on the Edit menu, and an [Enter Optional Fields] button on the toolbar.

When you select the **Edit > Custom Fields** option or click the [Enter Custom Fields] button:

- If any custom fields have been defined for the parent window, the **Custom Fields** window opens. You can display the custom fields and change the custom field values for a record you are working with.
- If no custom fields have been defined for a window and you are signed in as a company administrator, the **Custom Field Properties** window opens.

The following sections describe how you use these windows to create and view custom fields for your Sage 100 Contractor company.

About the Custom Fields window

The Custom Fields window displays a list of the custom fields that have been defined for the parent window. You use the Custom Fields window to view or to enter values for custom fields that have been added to a parent window.

If you sign in to Sage 100 Contractor as a company administrator, you can also add new custom fields or modify or delete existing ones:

- You click the [Add] button in the Custom Fields window to open the Custom Field Properties window where you can define a new custom field for the window you are working in.
Upgrading from version 19.8?

- You click the [Modify] button to open the Modify Custom Fields window. In the Modify Custom Fields window, use the icons beside the field you want to modify to:
  - Edit the properties of the field ( ).
  - Delete the field ( ).
  - Move the field up or down in the list ( ).

  **Tip:** If you want to keep the Custom Fields window open while you work with a record, click [Pin]. The window remains pinned to the top right edge of the parent window until you unpin it, even if you close and then reopen the parent window later. To unpin the window, click [Unpin] in the Custom Fields window.

### Defining Custom Fields for a Window

If you log on as a company administrator, you can define custom fields for any window that supports them. Sage 100 Contractor does not limit the number of custom fields you can define for a window or for your company.

You use the Custom Field Properties window to add, edit, and delete custom fields.

**Before you start**

Make sure you are logged into Sage 100 Contractor as a company administrator. You can add, edit, or delete custom fields only if you are logged in as a Company Administrator.

**To add a new custom field:**

1. In a window that supports custom fields, click Edit > Enter Custom Fields, or click the Enter custom fields button on the taskbar.

   If no custom fields have been defined for the window, the Custom Field Properties window appears immediately.

   If any custom fields exist for the window, the Custom Fields entry window appears. In the Custom Fields window, click [Add].

   **Tip:** If you want to modify or delete an existing field, you click the field in the Custom Fields window, and then either:

   1. Press F7 or
   2. Click [Modify],

   Then, on the Modify Custom Fields window, you click the Edit properties for this field button or the delete button.
2. Fill in the fields in the Custom Field Properties window as follows:
   a. In the Field Name box, type a unique name to identify the custom field, using six characters.
      
      **Note:** You cannot save a custom field with the same name as an existing custom field that has been defined for a window, and you cannot change the name after you save the custom field.

   b. In the Description box, type a brief description for the custom field, using up to 30 characters.

   c. From the Field Type list, select the type of data this field will contain. For example, if you will use the field to store a type of number, select Number.
      
      **Note:** You cannot change the field type after you save the custom field.

   d. Depending on the Field Type you selected in the previous step, fill in additional attributes for the custom field:
      
      - **Length.** For Character field types, enter maximum number of characters (use up to 255 characters) that the custom field can accept.
      
      - **Decimal Places.** For Number field types, select the number of decimal places (0, 2, 4, or 6) that numeric entries will use.
      
      - **Maximum Value / Minimum Value.** If you want to track a standard currency value, you need to set maximum and minimum values. The maximum value must be no greater than 999,999,999 and the minimum value should be no less than -99,999,999. The default values for these fields. Numeric fields must have a maximum value greater than zero. You cannot use the same values for Minimum Value and Maximum Value.
      
      - **Prompt.** For all field types, type a prompt to help users understand what to enter in the custom field when they are processing records.
      
      - **Default Entry.** For all field types, type or select (if a list is available) the entry to display as the default for the field.

         Character fields can accept default entries, but not "Next" or "Previous."

         Date fields display the date that occurs the number of days you specify after the current date ("TODAY").

         Check boxes can be selected, or not, by default.

   e. Set other options as follows:
      
      - **Require Entry.** Requires an entry, or Sage 100 Contractor will not save the record.
      
      - **Use Quick List.** You can provide a Quick List control for a customer field by selecting the Use Quick List check box.
      
      - **Require List Match.** Requires that the entry match an item on the Quick List.
      
      - **Lock Quick List.** Prevents users from editing a Quick List. Only a company administrator can edit the information.
      
      - **Lock After Save.** Prevents users from editing the information after saving the record. Only a company administrator can edit the information.
- **Require Unique.** Prevents users from entering duplicate information. This is available for indexed text boxes that let you enter character-based information.
- **Check Spelling.** Checks the spelling when you move to another text box or cell. If Sage 100 Contractor finds a misspelled word, it displays the Spelling dialog box.
- **Mixed Case.** Allows text entry in upper and lower case.
- **Upper Case.** Displays text only in upper case.
- **Lower Case.** Converts entry to lower case text.
- On the Permit Access to list, select the user groups that should have access to the field. If you do not select any user group, all user groups have access.

3. Click [Save].

**View Change History in Records**

Many data entry windows in version 20.7 include a new View menu, with options that enable company administrators to view the history of changes to a selected record.

This capability can be helpful when you need to determine the source or the timing of a change in a record.

**Notes:**

- The depth of the change history is determined by the retention policy set for your company in Database Administration. History is retained for 180 days by default, but you can change the retention period.
- You do not have to log into the company with Administrator rights to view history, providing you are set up as a company administrator in the 7-7-2 User List.

When you display a record in a window that has a View menu, you can select one of two options to view history:

- **View > Record history.** When you select this option, a separate View History window opens, displaying a list of all the changes to the current record.
  - Initially, the list summarizes all the changes to the record, showing for each change:
    - The database table that was updated,
    - Whether new information was inserted or existing information was modified or deleted.
    - The date and time.
    - The login ID of the user who made the change.
    - The ID of the computer where the change originated.
    - The application where the change originated (for example, Sage 100 Contractor, Database Administration, or SQL Server Management Studio).
  - Tip: If there were many changes, you can filter a long list to show only changes for a particular table, user, or application.
To view the details of a particular change, click the row on which the change is listed. Sage 100 Contractor displays a **History Details** window that shows, for each field in the record, the value of each field before and after the change.

**View > Field history.** When you select this option, field entries that have changed for the current record are displayed against a yellow background.

To view change details for a particular field, click the field, and then press [F12]. Sage 100 Contractor displays a separate **History** window for the field that lists the ID of each person who made a change, the date of the change, the field values before and after the change, and the application where the change originated.

**Note:** With View Field History turned on, you cannot edit the record.

The view history options are turned off when you close the window or move to another record.

**Note:** Although the following windows include a View menu, some special conditions apply:

- In **5-2-1 Employees**, history is not provided for the **ACA** tab.
- In **5-2-2 Payroll Records**, history is not provided for the **Calculations** tab.

### Assign banking categories to bank-related journal transactions

You can now classify bank-related journal transactions as adjustments, checks, or deposits for bank reconciliation.

The new **Banking Category** field in the **1-3 Journal Transactions** and **1-4 Recurring Journal Transactions** windows lets you classify a bank-related transaction as a 0-Adjustment, 1-Check, or 2-Deposit. The category you assign to an entry determines its classification in the **1-5 Bank Reconciliation** grid.

**Tip:** You can drill down from a record in the 1-5 Bank Reconciliation window, change the category for the transaction, and save it. When you refresh 1-5 Bank Reconciliation grid, the record appears correctly in the new category.

The new **Banking Category** field is always present in the **1-4 Recurring Journal Transactions** window, but it appears in the **1-3 Journal Transactions** window only for new records and for existing records that use a 3, 4, 19 or 21 Source code (which are classified as adjustments by default).

When you post a record in the **1-4 Recurring Journal Transactions** window, the Banking Category value is passed automatically to the **1-3 Journal Transactions** record.

### Tag rows for follow-up in the 9-5 Takeoffs grid

You can tag rows in the **9-5 Takeoffs** grid, marking them for future follow-up. When you tag a row, you can add a note to remind you why you tagged the line (for example, “Check this number with subcontractor XYZ”).

Headers for rows that you have tagged in the takeoff grid display a red triangle, helping you to identify them.
To tag a row in the 9-5 Takeoffs grid:

1. Right-click any field in the row that you want to tag.
2. On the shortcut menu, click Add/Edit Row tag.
   - A Row Tag window appears. It identifies the bid item, phase, and row number of the row you are tagging. It also provides space to enter a note.
3. In the Tag Note box, type the reason you are tagging this takeoff detail.
4. Click [OK].

To view a single tag note later, you can open the Row Tag window for the detail, just as you did to tag the detail.

To view a list of all the tag notes for the entire takeoff, click the [RowTags] button at the bottom of the window. In the Takeoff Row Tags for Job# window that opens, you can select a row tag, and then:

- Click [Go to Row] to go to that detail in the takeoff grid.
- Click [Remove] to remove the note and the tag for one or more selected rows.

Replace Cost Codes, Vendors, Tasks, or Inventory Locations in a takeoff

A new replacement function in the 9-5 Takeoffs window enables you to replace cost codes, vendors, tasks, or inventory locations in takeoffs quickly and efficiently. For example, if your takeoff template contains "Inactive" cost codes, vendors, tasks, or inventory locations, you can easily replace these codes with active ones.
To replace codes in a takeoff:
1. In the 9-5 Takeoffs window, click Update > Replace.
2. In the Replace Cost Codes, Vendors, Tasks, or Inventory Locations window:
   a. Select the type of item you want to replace in the takeoff. (You can replace cost codes, vendors, tasks, or inventory locations.)
   b. In the Original Value box, select the value that you want to replace.
   c. In the Replace with box, select the new value to use or type it.
3. Click [Replace].

Caution! You cannot undo this action, although the changes do not affect the database until you save the takeoff. If you close the takeoff without saving, the replacement data is lost.

When you click [Replace], the program replaces the specified original values for all takeoff grids for the selected job.

Correct the period of a posted payroll transaction

If you post a payroll transaction to the wrong period, you can use the new Change Period for Posted Records option in the 5-2-2 Payroll Records window to correct the period.

This procedure updates the existing record directly to move it to the new period, rather than reversing and replacing the existing record.

Before you start

Note: You must log into the company as an administrator with exclusive access to use this feature.

To correct the period of a posted transaction:
1. Open the 5-2-2- Payroll Records window.
2. On the Options menu, click Change Period for Posted Records.
   The Change Posted Payroll Period window opens.
3. Enter criteria to select the payroll records that you want to change.

4. From the Change Period To box, select the correct period to which to post the payroll records.

5. Click [Preview Records] to view a list of the records that match your selection criteria, and verify that these are the records you need to change.

If the list contains unexpected results, adjust the criteria until only the records you want to change are included.

6. Click [Change Records].

Sage 100 Contractor:
- Updates all payroll records that have a ledger reference, including Void records.
- Updates the general ledger and job and equipment costs with the new period and fiscal year.
- Recalculates the ledger balances.

**New Aging Reports**

**Combined Accounts Receivable and Service Receivables reports**

If you are involved in both construction and services, you no longer have to print separate reports for Accounts Receivable and for Service Receivables. You can print the following new combined Accounts Receivable and Service Aging reports by due date or invoice date, as indicated:

- 81—Combined AR/SR Invoice Aging
- 86—Combined AR/SR Invoice Aging—Land

This version of the software has been retired.
You can print these locked reports using either the **3-1-3 Receivable Aging** or the **11-1-3 Service Aging** report printing windows.

### Print New Accounts Receivable Aging Reports by Invoice Date

You can print new **AR Aging reports** by invoice date. These new reports are:

- 51—AR Invoice Aging—Aged by Invoice Date (locked)
- 56—AR Invoice Aging—Land; Aged by Invoice Date (locked)
- 61—Job Current Aging—Aged by Invoice Date (U.S. only)
- 62—Job Current Aging—Alpha; Aged by Invoice Date
- 66—Job Current Aging—Land; Aged by Invoice Date
- 67—Job Current Aging—Land; Alpha; Aged by Invoice Date
- 71—Job Period Aging—Aged by Invoice Date
- 72—Job Period Aging—Alpha; Aged by Invoice Date
- 76—Job Period Aging—Land; Aged by Invoice Date
- 77—Job Period Aging—Land; Alpha; Aged by Invoice Date

### Print New Accounts Payable Aging Reports by Invoice Date

You can also print **AP Aging reports** by invoice date. The new reports are:

- 4-1-3-51—AP Invoice Aging—Aged by Invoice Date (locked)
- 4-1-3-56—AP Invoice Aging—Land; Aged by Invoice Date (locked)
- 4-1-3-61—Vendor Current Aging—Aged by Invoice Date
- 4-1-3-62—Vendor Current Aging—Alpha; Aged by Invoice Date
- 4-1-3-66—Vendor Current Aging—Land; Aged by Invoice Date
- 4-1-3-67—Vendor Current Aging—Land; Alpha; Aged by Invoice Date
- 4-1-3-71—Vendor Period Aging—Aged by Invoice Date
- 4-1-3-72—Vendor Period Aging—Alpha; Aged by Invoice Date
- 4-1-3-76—Vendor Period Aging—Land; Aged by Invoice Date
- 4-1-3-77—Vendor Period Aging—Land; Alpha; Aged by Invoice Date

### Print New Service Invoice Aging Reports by Invoice Date

You can print the following new **Service Invoice Aging reports** by invoice date:

- 11-1-3-51—Service Invoice Aging—Aged by Invoice Date (locked)
- 11-1-3-56—Service Invoice Aging—Land; Aged by Invoice Date (locked, U.S. only)
- 11-1-3-61—Client Current Aging—Aged by Invoice Date (U.S. only)
Filter cost codes by Job and Phase in Lookup windows

When you search for cost codes in a lookup window, you can apply filters to include only the cost codes that pertain to a specific job and phase or you can display all the cost codes you use for your company. A filtered search is very efficient, especially if your company has a large number of cost codes and you are interested only in cost codes for a particular job.

You can use three types of filters to search for cost codes:

- All
- Job
- Job/Phase

When searching for cost codes, the filters that are available depend on the structure of the job and budget:

- If a job has a budget, you can select a filter.
- If the job has a budget but no phases, you cannot filter by Job/Phase.
- If the job has no budget at all, no filter is available.

If you set up a job with phases, and each phase has a budget, the search yields only cost codes included in the budget for that job and phase. If the job has a budget but no phases, the search yields only the cost codes for the job. If there is no budget, the resulting list includes all the cost codes in your company database.

Filtering rules also apply to cost divisions. If the budget has no cost codes for site work and you select the site work division, the search yields no results. To see the site work cost codes, you must switch the filter to All.

New Option for Company-Specific Custom Reports and Forms

You can now create reports and forms for a specific company that are accessible to all users when they print reports for that company.

To modify an existing company-specific report or form, later, select Display Company Reports or Display Company Forms.

Company-specific report and forms are located in the Sage100Con > Company > [company] > Files > Custom Reports or the Sage100Con > Company > [company] > Files > Custom Report Forms folder, respectively.
Use a new standard calendar to select dates

Sage 100 Contractor now displays a standard calendar as the date picker for date fields.

To select a date:

1. Press F5 or click the Display calendar button in a date field, or select Display calendar from the shortcut menu on a date cell in a grid.
   
   If you selected a date previously, that date is highlighted in the calendar.

2. Double-click the date you want to use.
   
   You are returned to the date field, which now displays the date you selected.

**Tip:** If you prefer to use the old company calendar, simply press F2 after clicking in the date field.

Support for Customized Tables and Views

Administrators and third-party developers can now add customized tables and views to Sage 100 Contractor databases. Sage 100 Contractor reserves a special namespace designation for customizations, preventing potential conflicts with future software development, or the creation of incompatible customizations.

Before you can add tables and views, you must create a schema with a name that begins with dbx_ to identify it as a custom schema. Dbx_ should be followed by your company name or another unique label that will distinguish it from other third-party schemas. For example, Rupert Everett Consulting could create a schema called dbx_REVERETT.

You can then add tables and views to this schema, and you can add multiple schemas, as needed.

More versatile Lookup windows

Sage 100 Contractor provides a consistent and versatile set of enhanced Lookup windows throughout the program.

Using the new Lookup windows, you can view information and select records in convenient new ways, including:

- Choose columns to display or hide in a Lookup window.
  
  On the Options menu in any Lookup window, click Select Columns to Show, then select the check boxes for each column you want to display in the Lookup window, or clear the check box to hide a column from view.
- View the names associated with columns that display certain numbered records, for example, the vendor names for vendor numbers, job names for job numbers, account names for account numbers, and so on.

  Sage 100 Contractor displays name columns automatically for these numbered records, identifying them by enclosing the column heading in parentheses, for example "(Vendor Name)."

  **Note:** You cannot hide these name columns while the associated number column is displayed, although you can minimize the column width by dragging the right edge of the column header. If you hide a number column, the associated name column is also hidden.

- Change the order in which columns appear in a Lookup window.

  Simply grab the column heading for a column you want to move, then drag it left or right until it is positioned where you want it to be.

  **Note:** If you separate a name column from its associated number column, the Lookup window does not retain the new position the next time you open the Lookup window. The name column always appears beside its associated number column when you open any Lookup window.

- View more accurate results, and find records more quickly, when you begin typing a search term in a data control box.

  The new Lookup windows display only the records that begin with the characters you type, filtering even more effectively as you continue typing.

  When you see the record you want, select it on the list and then press [Enter] to use it in the transaction or other window you were working with.

  When you close the window, Sage 100 Contractor automatically saves your display preferences, so columns appear as you want them the next time you use Lookup features in that window.

**Enhancements for the U.S. Edition**

- The **Sales Tax Districts** window now includes a column to show the effective tax rate for each tax district. You can also add this column to the Tax Districts lookup window using the **Options > Select Columns to Show** option in the lookup window.

**Improved vacation tracking**

Version 20.6 made it easier for you to administer vacation for your employees. It can also help to prevent you from paying out vacation (or paid time off) when the employee has not accrued sufficient time or if they have reached a specified maximum.

For example, suppose you establish a maximum vacation accrual of 1.5 times the annual accrual rate. If an employee is entitled to 40 hours vacation per year, they would not be able to accrue more vacation when they have accrued 60 hours. When they take vacation, dropping their accrued vacation below 60 hours, vacation begins to accrue again.

You use the **5-2-1 Employees** window and the **5-2-2 Payroll Records** window to track vacation accruals:

- The **Compensation** tab in the **5-2-1 Employee** window includes new **Accrual Maximum** and **Last Year Carry Forward** fields for vacation hours. Sage 100 Contractor uses these amounts as follows:
During payroll close, accrued vacation is copied to the Last Year Carry Forward field.

The 5-2-2 Payroll Records window now displays accrued Vacation available (in hours) for a selected employee. You no longer need to refer to the employee record to obtain the vacation available.

When you select an employee in this window, Sage 100 Contractor displays their vacation available, provided their pay is subject to vacation accrual. Negative vacation available is displayed in red.

**Note:** Vacation available is displayed only for new or Open status records.

During the payroll final compute, when calculating an employee’s accrued vacation, the program includes the vacation accrued and vacation taken in the current period, while respecting the accrual maximum from the employee record. The employee will not accrue more than the stipulated maximum. Also, Sage 100 Contractor warns you if vacation for the current payroll record would result in negative accrued vacation for the employee. If you choose to skip the final compute format payroll record, the transaction is rolled back, and that payroll record maintains an Open status.

### Summary of Enhancements in Earlier Versions of Sage 100 Contractor (SQL)

The following table is a comprehensive list of features introduced in earlier versions, details of which you can read about in the Release Notes for the respective version.

<table>
<thead>
<tr>
<th>Enhancements by version</th>
<th>U.S. Only</th>
<th>Canada Only</th>
<th>API</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version 20.7 enhancements</strong> (Details are available in the v20.7 Release Notes)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ability to print a new 5-1-8-86 Vacation Hours Earned and Used Report</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Version 20.6 enhancements</strong> (Details are available in the v20.6 Release Notes)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Server Management Tools</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ability to set records &quot;Inactive&quot;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>More efficient login</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ability to replace Cost Codes, Vendors, Tasks, or Inventory Locations in a takeoff</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Combined Accounts Receivable and Service Receivables aging reports</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ability to print Accounts Receivable Aging Reports by Invoice Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ability to print Accounts Payable Aging Reports by Invoice Date</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This version of the software has been retired.
<table>
<thead>
<tr>
<th>Enhancements by version</th>
<th>U.S. Only</th>
<th>Canada Only</th>
<th>API</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ability to print Service Invoice Aging Reports by Invoice Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New banking categories you can assign to bank-related journal transactions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Improved vacation tracking</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>A variety of customer-requested enhancements, including a new Refresh option to update a report you are previewing with recent information, new access buttons in the 3-5 Jobs window, and more!</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Version 20.5 enhancements**
(Details are available in the [v20.5 Release Notes](#))

- We implemented a variety of customer-suggested enhancements.
- Ability to use new custom fields in most windows
- Ability to tag rows for follow-up in the 9 -5 Takeoffs grid
- Audit Information is available in Advanced Company Settings
- Numeric fields provide automatic calculation
- Easier access to user subfolders in workgroups
- Ability to correct the period of a posted payroll transaction
- Ability to skip automatic calculation during takeoff
- Ability to filter cost codes by Job and Phase in lookup windows
- Ability to filter unassigned work orders on the Dispatch Board
- There is a new option for saving and selecting company-specific custom reports and forms
- Ability to use a new standard calendar to select dates
- Support for Microsoft SQL Server 2016 and Windows 2016 Server
- Ability to copy user process maps
- Ability to use high contrast display settings for Windows 10
- Ability to print a new Payroll Check Register 5 -1 -2 -31 by check date
- 3 -7 Progress Billing and 12 -2 Inventory Allocation allow 5,000 rows
- Tax and Workers’ Comp rates in 4 -4 and 4 -2 use 4 decimal places
- Workers’ Comp Reports 21, 86, and 96 show Overtime Hours

*This version of the software has been retired.*
## Enhancements by version

<table>
<thead>
<tr>
<th>Version</th>
<th>U.S. Only</th>
<th>Canada Only</th>
<th>API</th>
</tr>
</thead>
</table>
| **Version 20.4 enhancements**  
(Details are available in the v20.4 Release Notes) |           |             |       |
| Ability to copy external files to other users |         |             |       |
| New option to approve the removal of employee records |     |             |       |
| **Version 20.3 enhancements**  
(Details are available in the v20.3 Release Notes) |           |             |       |
| Ability to view change history in records |         |             |       |
| New option for closing purchase orders automatically |     |             |       |
| Support for Sage Exchange Desktop 2.0 |         |             |       |
| Support for customized tables and views |     |             |       |
| Ability to use a new window to add client service locations quickly | X |             |       |
| Effective rate shown for Sales Tax Districts (U.S. only) | X |             |       |
| API supports adding and removing attachments | X |             |       |
| API enforces locks | X |             |       |
| Schema change for Global Variables | X |             |       |

## Notes for Third-Party Developers

### API Support for Adding and Removing Attachments

The API supports adding and removing attachments on all Sage 100 Contractor forms that support attachments and have API support for **Add**, **Modify**, and **Delete**.

This version of the software has been retired.
As with the existing API for Work Orders, these changes do not include support for:

- Changing the description on attachments
- Web links

**Other API Enhancements**

The Sage 100 Contractor API now:

- Supports custom fields, enabling third-party products to add custom fields and to add data to custom fields through the API.
- Blocks the use of Inactive records in new records and prevents changing an existing record to use an Inactive-related field. (The returned error code is 14057.)

**Migrating your company data from version 19.8**

**Important!** You must be using Sage 100 Contractor version 19.8 to migrate your company to version 20.7. If you are using an earlier version of Sage 100 Contractor, you must first upgrade your company data to version 19.8.

You use the migration utility in the new Database Administration tool to automatically migrate and upgrade your data to version 20.7, including all company data in folders and subfolders of \MB7\[CompanyName].

Migrated files are located in shared folders under \ServerName\CompanyName. These subfolders are organized using a similar folder structure as in earlier versions, and include:

- Aatrix Forms
- Attachments
- Direct Deposit
- Images
- Reports

The Direct Deposit and Reports folders are available as soon as you open the company in Sage 100 Contractor. The remaining folders are created as needed.

**Note:** For detailed, step-by-step instructions on migration, see the Database and Company Administration Guide or the Database Administration help.

**Preparing for migration in version 19.8**

Migration should proceed smoothly in most cases. However, you should audit your accounting data and your company, payroll in version 19.8, and then fix any errors, before attempting migration to version 20.7.

Use the following audit tools to prepare your data in version 19.8:
• 1-6 Period and Fiscal Year Management > Audit Books
• 5-3-7 Payroll Audit
• 6-6-3 Purchase Order Audit
• 6-7-4 Subcontract Audit
• 12-5 Inventory Audit

Note: If your data includes serious audit errors, you may need assistance from your business partner or consultant to prepare your database for migration.

Migrating reports

The new Database Administration tool also includes a utility to migrate and upgrade Sage 100 Contractor reports and reports written with the Sage 100 Contractor report designer.

In version 20.7, shared custom reports and form designs are located in these folders:

- \ServerName\Sage100Contractor\Custom Reports
- \ServerName\Sage100Contractor\Report Forms

Private custom reports and form designs are located in Sage 100 Contractor User Data folders associated with each user name, as follows:

- \ServerName\Sage100Contractor\UserData\username\Custom Reports
- \ServerName\Sage100Contractor\UserData\username\Report Forms

Updating custom reports

You also need to update custom reports created with third-party software, such as Crystal Reports, so they map to the new database.

We recommend that you use the new report views that come with version 20.7 to create or update reports. The new views were created for your convenience, so that future database changes will not necessarily break your custom reports.

After migrating your company data

After migrating your data, you will likely need to perform the following additional steps to prepare your company for use in Sage 100 Contractor:

Importantly, Use Database Administration, not SQL Server Management Studio, for all these tasks.

- Add company administrators. There is no longer a generic "supervisor" user as there was in earlier versions. All users must sign into the company using their personal IDs, and only users designated as company administrators have heightened privileges previously associated with the "supervisor" role. You can designate one user as a company administrator during migration, but you can add others later.
Add SQL logins for new users. If you have new users that did not exist in your version 19.8 company, add them as users to the SQL database.

You must also add them as users and assign security in Sage 100 Contractor.

Designate an additional SQL Server administrator. Only a user with system administrator privileges for the SQL instance can administer users for SQL Server or assign the system administrator role to another user. Therefore, it is vital at all times that more than one user has a system administrator role. If the principal system administrator should suddenly fall ill, or leave your company, or otherwise be unable to perform their duties, another person with administrative access to the SQL Server database must be able to take over that role.

**Note:** The person who installs Sage 100 Contractor is automatically assigned a 'sysadmin' role in SQL Server. When they designate a SQL Server administrator in Database Administration, that person is also assigned the 'sysadmin' role in SQL Server.

Switch your Sage Construction Anywhere to version 20.7. If you have been using Sage Construction Anywhere with Sage 100 Contractor version 19.8 and want to use it with version 20.7, you will need to switch the connection to version 20.7. For help on switching the connection, see the instructions in the Installation and License Administration Guide.

Migrate your Sage ACT! settings to version 20.7. If you have been using Sage ACT! with Sage 100 Contractor version 19.8 and want to use it with version 20.7, you need to change your ACT! settings to point to your new version 20.7 company database. For help on migrating your ACT! settings to version 20.7, see the instructions in the Installation and License Administration Guide.

Migrate each user’s scheduled reports from version 19.8. See the instructions in the Installation and License Administration Guide.

Migrate each user’s alerts from version 19.8. See the instructions in the Installation and License Administration Guide.

### Changes to converted data

During migration, the program may encounter problems that might prevent it from writing a particular record to the new SQL Server database.

If the problem is that the migration program can fix, it repairs the record, and then writes the updated record to the SQL Server database. For a list of the types of errors that can be fixed during migration, see the Database and Company Administration Guide.

**Note:** Not all errors can be fixed during migration. In these cases, the record is not written to the new database.

### The migration log file

The program keeps a log of all changed records and records that were not migrated because of an unresolved error, unless the record was invalid in version 19.8. (Invalid records are neither migrated nor logged.)

After migration, you should check the log file to see what changes were made to your data during conversion, or whether any records were not migrated to the new SQL database.
The _SQL_MIGRATION_LOG.TXT file is located in the source company's main folder (for example, C:\MB7\Sample Company). A supplemental file, _SQL_MIGRATION_LOG_VERBOSE.TXT, includes more detailed information about each error found.

**Using Sage 100 Contractor Intelligence Reporting with Sage 100 Contractor 2017**

Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.

If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in [Knowledgebase article 75640](#) when upgrading to version 20.7.

This version of the software has been retired.
Known Issues and Comments

The following sections describe known issues and problems in Sage 100 Contractor Version 20.7.

General

Internet access required for Sage 100 Contractor

Sage 100 Contractor features, such as printing or e-filing tax forms, submitting enhancement requests, accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the Internet to obtain licenses. Once installation is complete, you can check license uses for each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the Internet.

**Note:** A static Internet connection using a compatible web browser is required for Sage Construction Anywhere. For current information on supported browsers, supported Sage 100 Contractor versions, and other system requirements, see the Sage Construction Anywhere help at http://help.sageconstructionanywhere.com/sage100contractor/help/default.htm#01_Setup/System_requirements.htm.

Configuring anti-virus software and third-party firewalls

During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you may need to manually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party firewall products.

**To configure the Windows Firewall:**

   For Windows 7, click Start > Control Panel > System and Security.
   For Windows 8.1 and Windows 10, click Start > All apps > Control Panel > System and Security.
2. Open Windows Firewall, and then select Allow a program or feature through Windows Firewall.
3. Select Sage 100 Contractor Hosting Framework on the list, if it is not selected.

**Note:** By default, the exception is set to allow access by any computer on the network. You can refine this setting by selecting the Change Scope button. Be aware that restricting the scope incorrectly can cause the computer to be unable to connect with some or all of the other machines on the network.
Files to exclude when manually configuring your firewall for Windows 8.1 Professional 32-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 8.1 Professional 64-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)
Known Issues and Comments

Files to exclude when manually configuring your firewall for Windows 8.1 Professional

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Files to exclude when manually configuring your firewall for Windows Server 2008 R2, 2011, 2012

- C:\ProgramData\Sage\Sage 100 Contractor
- C:\ProgramFiles (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data. (If you install SQL Server Express using Database Administration, this location is C:\Sage100Con\Company\.)

Software and hardware required to support Microsoft SQL Server

Version 20.7 requires an instance of Microsoft SQL Server. You can download and use Microsoft SQL Express at no charge, or you can use the full version of Microsoft SQL Server. You can even start using Microsoft SQL Express, and upgrade to the full version of Microsoft SQL Server later, if necessary.

When you first open the new Database Administration tool, the program tries to configure an instance of Microsoft SQL Server with optimal settings for Sage 100 Contractor for you. If you do not already have an instance of Microsoft SQL Server, you can let the Database Administration tool download, install, and configure Microsoft SQL Express for you.

Refer to Knowledgebase article 84502 for detailed information about supported operating systems and software, and for minimum hardware requirements.

Installation of Microsoft SQL Server on a domain controller is not recommended

Microsoft recommends against installing SQL Server on a domain controller, and does not support SQL Server on a read-only domain controller should you encounter any problems with this configuration.

Because you must install Database Administration on the same machine as SQL Server, you should not install Database Administration on a domain controller. To guard against inadvertent installation on a domain controller and the potential for irrecoverable data losses, you will receive a warning if you attempt to install Database Administration on a machine used as a domain controller.
About .NET Framework

.NET 4.6.1 Framework is required

If Microsoft .NET 4.6.1 Framework is not already installed, it will be installed automatically when you install Sage 100 Contractor. Installation of .NET 4.6.1 Framework alone may take up to 20 minutes per computer.

Make sure that both your client and server computers meet the minimum requirements for installing both Sage 100 Contractor software and .NET 4.6.1 Framework.

**Note:** If Sage 100 Contractor requires an installation of .NET 4.6.1 Framework, the Sage 100 Contractor installation process may continue automatically after the .NET Framework installation is completed. If you are prompted to restart your computer after the .NET Framework installation, you must do so to continue the Sage 100 Contractor installation.

.NET 3.5 is also required

In some situations, you may need to turn on .NET 3.5 manually by selecting the .NET 3.5 check box in the Windows Features dialog box. For more information, see Knowledgebase article ID 68381, available at [https://support.na.sage.com/selfservice/viewdocument.do?externallId=68381](https://support.na.sage.com/selfservice/viewdocument.do?externallId=68381).

Windows Small Business Server 2011 is not supported

Microsoft Small Business Server 2011 does not support .NET Framework 4.6.7, which Sage 100 Contractor (SQL) requires. Unfortunately, this means that Sage 100 Contractor (SQL) cannot support Small Business Server 2011.

Turning on Microsoft .NET 3.5

Microsoft .NET 3.5 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2 machine. Server 2008 R2 comes with .NET 3.5 loaded but not installed, so Sage 100 Contractor does not install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5 installed, you receive the following message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5 has been installed. If you receive the above message during installation, install .NET Framework 3.5, and then reinstall Sage 100 Contractor.

The following instructions are for Windows Server 2008 R2.

To verify that .NET 3.5 is installed on Windows Server 2008 R2:

1. Click the Start button in the lower left corner of the display.
2. Highlight Administrative Tools and select Server Manager.
3. In the Server Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that .NET Framework 3.5.1 is listed.
To enable .NET 3.5 on Windows Server 2008 R2:

1. In the Server Manager interface, select Add Features to display a list of possible features.
2. In the Select Features interface, expand .NET Framework 3.5.1 Features.
3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET Framework 3.5.1 and click Next.
4. In the Confirm Installation Selections interface, review the selections and then click [Install].
5. Allow the installation process to complete and then click [Close].

Note: Enabling .NET Framework 3.5.1 may require a reboot.

About network configuration and TCP Remoting Channel

Sage 100 Contractor usesthe TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations can potentially disable the communication:

- You must enable file sharing on your computers. To enable file sharing, follow the instructions in the Windows Help.

- TCP communication requires the selection of port numbers that are not in use by other processes on the local computer.

- Software firewalls running on the local computer can be configured to block processes from opening TCP ports, which will prevent communication through the TCP Remoting Channel.

Sage Advisor Update

Sage Advisor Update is a notification and download service that alerts you when an update is available for Sage 100 Contractor. You can use Sage Advisor Update to download and install updates available for Sage 100 Contractor and other Sage products for which you have a current Sage Business Care Plan.

Tip: Use the Customize settings in the Windows system tray to make sure you can view the Sage Advisor Update icon and notifications from the System Tray in your Taskbar.

For more information about Sage Advisor Update, see “About Sage Advisor Update” in the Installation and License Administration Guide and in the Sage 100 Contractor help.

PCI DSS Compliance

PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by the major credit card companies as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and other security weaknesses and threats.

A company processing, storing, or transmitting payment card data must be PCI-compliant or risk losing its ability to process credit card payments and being audited and/or fined. (For more information about PCI standards, see [https://www.pcisecuritystandards.org/](https://www.pcisecuritystandards.org/))

---

This version of the software has been retired.
Sage 100 Contractor payment processing works exclusively with Sage Payment Solutions to enable merchants to seamlessly process check and credit card transactions directly in Sage 100 Contractor. The payment processing program uses Sage Exchange, a secure payment-processing application, to connect to Sage Payment Solutions and process check and credit card transactions.

Integrating your financial and operations system with Sage Payment Solutions lets you process check and credit card transactions without storing your customers’ sensitive card information in your database. Sage Exchange transmits check and credit card details through a secure connection to Sage Payment Solutions, where they are stored in a PCI-compliant vault, protecting your from exposure to non-compliance penalties and credit card fraud.

**Caution!** To avoid non-compliance with PCI standards, do not store credit card information in Sage 100 Contractor. Such storage creates unnecessary risk for your business and your customers.

**Using Sage 100 Contractor Intelligence Reporting with Sage 100 Contractor 2017**

Sage 100 Contractor Intelligence Reporting versions 20.2 and 19.7 are not designed to work side-by-side.

If you used Sage Intelligence Reporting with Sage 100 Contractor version 19.8 or earlier, follow the steps in Knowledgebase article [75640](#) when upgrading to version 20.7.

**Tax Forms and eFiling by Aatrix configuration requirements**

Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

- For updating forms and executable files.
- For electronic filing (eFiling) of the forms.

If you experience an Internet connection problem, it may be due to problems communicating through an Internet firewall. Firewalls need to have access allowed through specific ports:

- The Tax Forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site [http://updates.aatrix.com](http://updates.aatrix.com).
- The eFiling component uses secure HTTPS on port 443 to access the site [https://efile.aatrix.com](https://efile.aatrix.com).

By allowing access to aatrix.com, you allow both updates and eFiling. Occasionally, restrictions are tighter and only allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the Internet.

For updating using http on port 80 to [http://updates.aatrix.com](http://updates.aatrix.com):

- aatrixforms.exe
- updater.exe
- updater2.exe

For eFiling using secure http on port 443 to [https://efile.aatrix.com](https://efile.aatrix.com):

- builder.exe
- viewer.exe

This version of the software has been retired.
Printing reports at year-end (U.S. Edition)

As of Version 19.2, in the U.S. Edition, if you pay retainage in the current year for a prior year invoice and then you print a 4 1 3 26 AP Aging report for the prior year, the report shows a reduced retainage amount, and the amount paid in the future period is allocated to the Current period or an aging period, depending on the due date of the retainage and the date it was paid.

Therefore, you should print these reports as part of your year-end processing to ensure that you have a set of reports that reflect the true amount of retainage outstanding at year end.

Tip: If you archive your data at year end, you can also print the reports from the archive company, later.

Printing reports to PDF or exporting to Excel?

When you print reports to PDF, you may find that the size of the PDF file is unexpectedly large and the resolution of the displayed PDF is not optimal.

To create a substantially smaller PDF file with good resolution, you can run Sage 100 Contractor in Compatibility Mode (compatible with Windows 7), and then print the report.

Note: You cannot export to Microsoft Excel when running Sage 100 Contractor in Compatibility Mode if you use Microsoft Office 2013.

We have not encountered this issue during testing, nor has it been reported for Windows Server 2012 R2.

Use Adobe Reader Version 8.1.3 or later for faxing

Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than 8.1.3. Adobe Reader Version 8.1.3 and later support faxing from Windows and from Sage 100 Contractor.

Important! To fax from Sage 100 Contractor, the Windows Fax Service component must be installed with your Windows operating system. For more information about installing the Windows Fax Service component, see the Sage 100 Contractor Help topic, “Installing the Windows Fax Service component.”

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8.1, Windows 7 Professional, Server 2008, or Server 2008 R2 Standard operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.
Configuring Windows Regional and Short Date Format

To specify regional formats for Windows:

1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region.
2. Click Region and Language.
3. On the Formats tab, select the format for your country.
4. Under Date and time formats, from the Short date format drop-down list, select the format used for your country.
5. Click [OK].
6. Close the Clock, Language, and Region window.

Posting Status for a Company Created since Version 19.2

If you created a new company using version 19.2, or higher, in certain limited scenarios an issue can arise after you advance the year to the first period of the new fiscal year. The new year may not be available when you try to change the posting period.

A fix to prevent this issue is included in the January 2015 update. However, if you have already encountered this issue, contact Customer Support for assistance.

Windows "Sleep Mode" prevents computers from obtaining a license use

If the computer you are using as a license server goes into sleep mode, other computers on the network cannot obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:  

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Windows 8.1 Professional and Server 2012 Standard Operating Systems

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8.1

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8.1 Professional or Windows 8.1 Enterprise operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.
Server 2012 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems

Launching Sage 100 Contractor to run as administrator for scheduling reports

**Important!** On computers running Windows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100 Contractor reports requires that you “run as administrator” or to “run the program as administrator.”

Microsoft Windows changed security rules in the Windows 7 Professional and Server 2008 R2 Standard operating systems to make your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, you must launch Sage 100 Contractor with the command to either **Run as administrator** or **Run this program as an administrator**.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you run the program as administrator for that session only. When you select **Run this program as an administrator**, you set program properties to always run the program as administrator when you log on to this computer.

**Note:** "Run as administrator" and "Run this program as an administrator" are not related to Windows 7 Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are running.

To set "Run as administrator":

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, to launch the program, click **Run as administrator**.

**Note:** Selecting **Run as administrator** only runs the current session of running Sage 100 Contractor. The setting does not persist after the session is over.

To set "Run this program as an administrator":

1. On your Windows desktop, right-click the Sage 100 Contractor program icon.
2. From the drop-down menu, click **Properties**.
3. On the Sage 100 Contractor Properties window, click the Compatibility tab.
4. Under Privileges Level, select Run this program as an administrator.
5. Click [Apply], and then click [OK].

**Note:** Selecting Run this program as an administrator always runs the program with these properties when you launch the program on this computer. The setting persists.

**Solution for Windows Server 2008 R2 "Permission Error Opening File"**

If you see a permission error message when launching Sage 100 Contractor on a computer running the Windows Server 2008 R2 operating system, follow these instructions:

1. On the Window desktop, right-click Start, and then click Open Windows Explorer.
2. On the left side of the window, under Computer > Local Disk, right-click the \Sage100Con folder, and then select Properties.
3. On the Sage100Con Properties window, click the Security tab.
4. From the list under Group or User Names, select USERS, and then click the Edit button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box.

Selecting Full control selects all the checkboxes necessary for this solution.
6. On the Permissions window, click [OK].
7. On the Sage100Con Properties window, click [OK].

**Solution for Windows 2008 Server R2 Application Error Message**

Under some circumstances, on servers operating Windows 2008 Server R2, you may see the following error message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open a image file in Sage 100 Contractor but you have not yet enabled the Desktop Experience feature in Windows 2008 Server R2. If you receive this error message, install Desktop Experience using the Server Manager utility:

1. In Windows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.
2. In the Server Manager window, click Features (left-hand pane).
3. In the Features pane, click Add Features.
4. Select the Desktop Experience check box.
5. If you are prompted to add additional features, click [Add Required Features].
6. Click [Next].
7. Click [Install].

This version of the software has been retired.